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[Abstract] Asymmetric cell division (ACD) is fundamental for balancing cell proliferation and 

differentiation in metazoans. During active neurogenesis in the developing zebrafish forebrain, radial 

glia progenitors (RGPs) mainly undergo ACD to produce one daughter with high activity of Delta/Notch 

signaling (proliferative cell fate) and another daughter with low Delta/Notch signaling (differentiative cell 

fate). The cell polarity protein partitioning-defective 3 (Par-3) is critical for regulating this process. To 

understand how polarized Par-3 on the cell cortex can lead to differential Notch activity in the nuclei of 

daughter cells, we combined an anti-Delta D (Dld) -atto 647N antibody uptake assay with label retention 

expansion microscopy (LR-ExM), to obtain high resolution immunofluorescent images of Par-3, dynein 

light intermediate chain 1 (Dlic1), and Dld endosomes in mitotic RGPs. We then developed a protocol 

for analyzing the colocalization of Par-3, Dlic1, and endosomal DeltaD, using JACoP (Just Another Co-

localization Plugin) in ImageJ software (Bolte and Cordelières, 2006). Through such analyses, we have 

shown that cytosolic Par-3 is associated with Dlic1 on Dld endosomes. Our work demonstrates a direct 

involvement of Par-3 in dynein-mediated polarized transport of Notch signaling endosomes. This bio-

protocol may be generalizable for analysis of protein co-localization in any cryosectioned and 

immunostained tissue samples.  
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[Background] Asymmetric cell division (ACD) of progenitor/stem cells is critical for generating cellular 

diversity in tissue differentiation and organogenesis during development (Chenn and McConnell, 1995; 

Fishell and Kriegstein, 2003; Williams et al., 2011). During ACD, each daughter cell acquires distinct 

fates after mitosis by asymmetric inheritance of cellular components (so-called cell fate determinants), 

e.g., one continuing to self-renew and the other embarking on a differentiation path (Horvitz and 

Herskowitz, 1992; Knoblich, 2001). Previous studies from our laboratory and others have shown that 

cell polarity protein Par-3 is required to establish the asymmetric activity of Notch signaling between 

daughter cells (Notchhi vs. Notchlo) (Mizutani et al., 2007; Bultje et al., 2009; Coumailleau et al., 2009; 

Dong et al., 2012; Derivery et al., 2015; Kressmann et al., 2015), a key regulator of cell fate decisions 
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(Artavanis-Tsakonas et al., 1999; Gaiano and Fishell, 2002). Recent studies show that Notch signaling 

in stem cell division is heavily controlled by endocytic trafficking (Chitnis, 2006; Daeden and Gonzalez-

Gaitan, 2018). In Drosophila sensor organ precursor (SOP) cells, Notch signaling endosomes undergo 

directional movement (Derivery et al., 2015). Built on these previous findings, we investigated how Par-

3 might regulate the dynamics of Dld endosomes in mitotic RGPs (Zhao et al., 2021).  

In this protocol, we describe our method for visualizing and analyzing cytoplasmic Par-3 in association 

with the dynein complex subunit Dlic1 and Dld endosomes in zebrafish RGP cells. The antibody uptake 

assay was used to label Dld endosomes in zebrafish embryos (Tong et al., 2019; Zhao et al., 2021). 

Following live labeling, cryosectioning, immunofluorescent staining, and label retention microscopy (LR-

ExM) (Shi et al., 2021) were carried out. We have optimized these procedures and the protocol detailed 

here should be generalizable to all cryosectioned and immunostained tissue samples, not limited to 

zebrafish. Subsequently, we obtained high-resolution images of mitotic RGP cells in the processed 

samples, using spin-disk confocal microscopy. The cytoplasmic areas between two nuclei of the 

anaphase/telophase RGPs were designated as the regions of interest (ROIs) for colocalization analyses 

of Par-3, Dlic1, and Dld. Because the size of endosomes (average diameters of 250 nm to 1000 nm) is 

much larger than the pixel size of fluorescent images, the fluorescence signals colocalized on Dld 

endosomes may not appear to exactly overlap with one another. Based on previously published reports 

(Bolte and Cordelières, 2006; Derivery et al., 2015), we developed the method for measuring co-

localization in the context of endosomes in this protocol. For all three channels, we measured the 

colocalization between every two fluorescent channels in the form of Manders’ Coefficients ( i.e., the 

proportion of each fluorescence colocalized with another) by using the JACoP plugin in ImageJ 

(Manders et al., 1993). Our results uncovered that Par-3 is colocalized with Dlic1 on Dld endosomes, 

hence revealing a direct role of cytoplasmic Par-3 in actively localizing intracellular determinants during 

ACD of RGP cells (Zhao et al., 2021).  

 

Materials and Reagents 

 

1. FisherbrandTM SuperfrostTM Plus microscope slides (Fisher Scientific, catalog number: 22-037-

246) 

2. 6-well glass bottom plates (CellVis, catalog number: P06-1.5H-N) 

3. Zebrafish strains wild-type zebrafish embryos were obtained from natural spawning of AB adults, 

staged and maintained according to established protocols (Kimmel et al., 1995) 

4. Zebrafish embryos were raised at 28.5 °C in 0.3× Danieau’s embryo medium (Zhao et al., 2021) 

5. Capillaries, 1.2 mm OD, 0.9 mm ID, with filament (World Precision Instruments, catalog number: 

1B120F-6) 

6. Tricaine (Sigma-Aldrich, CAS Number: 886-86-2, catalog number: E10521) 

7. Phenol red (Sigma-Aldrich, catalog number: P0290) 

8. Primary antibodies used in this study:  
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a. Mouse anti-Dld (Abcam, catalog number: ab73331; RRID, catalog number: AB_1268496; 

lot, catalog number: GR115501-3, 1:200 dilution for immunostaining) 

b. Chicken anti-GFP (Abcam, catalog number: ab13970; RRID:AB_300798, lot GR3190550-

20, 1:500 dilution for immunostaining) 

c. Rabbit anti-Par-3 (Millipore 07-330; RRID:AB_2101325; lot 3322358, 1:500 for 

immunostaining)(validated in this study) 

d. Guinea pig anti-DLIC1-Cter (a gift from Dr. T. Uemura, 1:100 for immunostaining) (Satoh et 

al., 2008) 

9. Secondary antibodies used for immunofluorescent labeling:  

a. Alexa®-conjugated goat anti-rabbit (Alexa 568, Invitrogen, catalog number: A11011, RRID. 

AB_143157, lot 792518, 1:2,000 dilution) 

b. Goat anti-chicken (Alexa 488, Invitrogen, catalog number: A11039, RRID:AB_142924, lot 

2020124, 1:2,000 dilution) 

c. Goat anti-mouse (Alexa 488, Invitrogen, catalog number: A11002, RRID:AB_2534070, lot 

1786359, 1:2,000 dilution) 

d. Goat anti-guinea pig (Alexa 488, Invitrogen, catalog number: A11073, RRID:AB_2534117, 

lot 46214A, 1:2,000 dilution) or Donkey anti-guinea pig (Alexa 647, Jackson Labs, catalog 

number: 706-605-148, RRID:AB_2340476, lot 102649-478, 1:2,000 dilution) 

10. Anti-Mouse-IgG-Atto647N (Sigma-Aldrich, catalog number: 50185, 1 mg/mL) 

11. Secondary antibodies used for tri-functional linker conjugation in LR-ExM were:  

a. Goat anti-Guinea Pig IgG (H+L) unconjugated secondary antibody (Invitrogen, catalog 

number: A18771, RRID:AB_2535548) 

b. Goat anti-Rabbit IgG (H+L) Cross-Adsorbed unconjugated secondary antibody (Invitrogen, 

catalog number: 31212, RRID:AB_228335) 

c. Goat anti-Chicken IgY (H+L) unconjugated secondary antibody (Invitrogen, catalog number: 

A16056, RRID:AB_2534729) 

12. NHS-MA-Biotin conjugated anti-Chicken IgY, NHS-MA-Biotin conjugated anti-Rabbit IgG, and 

NHS-MA-DIG conjugated anti-Guinea Pig IgG (Gift from Dr. Shi) (Shi et al., 2021) 

13. DAPI solution (1 mg/mL) (Thermo ScientificTM, catalog number: 62248) 

14. Tween 20 (Sigma-Aldrich, CAS Number: 9005-64-5, catalog number: P-9416) 

15. TritonTM X-100 (Sigma-Aldrich, CAS Number: 9036-19-5) 

16. Dimethyl sulfoxide (DMSO) (Sigma-Aldrich, CAS Number: 67-68-5) 

17. Natural goat serum (Invitrogen, catalog number: 31872) 

18. Glycerol (Sigma-Aldrich, CAS Number: 56-81-5G, catalog number: 9012) 

19. Phosphate-buffered saline (PBS) 10× solution, pH 7.4 (GibcoTM, catalog number: 70011044) 

20. Sucrose (Sigma-Aldrich, CAS number: 57-50-1) 

21. Tissue-PlusTM O.C.T. compound (Fisher Scientific, catalog number: 23-730-571) 

22. UltraPureTM low melting point agarose (Invitrogen, catalog number: 16520050) 

23. Sodium acrylate (Sigma-Aldrich, CAS Number: 7446-81-3) 
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24. Acrylamide (Sigma-Aldrich, CAS Number: 79-06-1, catalog number: A9099) 

25. Sodium chloride (Sigma-Aldrich, CAS Number: 7647-14-5, catalog number: 204439) 

26. N,N,N′,N′-Tetramethyl ethylenediamine, TEMED (Sigma-Aldrich, CAS Number: 110-18-9, 

catalog number: 1.10732) 

27. Ammonium persulfate, APS (Thermo ScientificTM, catalog number: 17874)  

28. Proteinase K (Sigma-Aldrich, CAS Number: 39450-01-6, catalog number: P4850)  

29. N,N′-Methylenebis-acrylamide (Sigma-Aldrich, CAS Number: 110-26-9, catalog number: M7279) 

30. 30× Danieau’s embryo medium (see Recipes) 

31. Blocking buffer for immunostaining (see Recipes) 

32. Washing buffer (see Recipes) 

33. LR-ExM gelation buffer and digestion buffer (see Recipes) 

34. Gelation buffer (see Recipes) 

35. Monomer solution (see Recipes) 

36. Digestion buffer (see Recipes) 

37. Post-digestion staining buffer (see Recipes) 

 

Equipment 

 

1. Stero dissection microscope (Zeiss Stemi 2000 with a maximum magnification of 50) 

2. Air pressure injector( Narishige IM 300 microinjector) 

3. Micromanipulators (WPI M3301R, World Precision Instruments, Sarasota, FL, USA) 

4. Flaming-Brown P897 needle puller (Sutter Instruments, Novato, CA, USA) 

5. Nikon CSU-W1 Spinning Disk/confocal microscope  

6. Leica CM1850 Cryostat 

 

Software  

 

1. Micro-Manager 2.0 gamma (μManagerTM, University of California), https://micro-manager.org/ 

2. Fiji (Schindelin et al., 2012), https://imagej.net/software/fiji/  

3. Prism 9, GraphPad, https://www.graphpad.com/ 

 

Procedure 

 

A. Anti-Dld antibody uptake assay in the one day post fertilization (1dpf) zebrafish brain 

1. Antibody conjugation: Mix 1 μL of anti-Dld antibody (0.5 mg/mL) with 2.5 μL of Anti-Mouse-IgG-

Atto647N antibody (1 mg/mL) and incubate at room temperature for 30 min, or on ice for 2–3 h. 

From this step, the mixture should be protected from light. 

2. Blocking of unconjugated antibody: Add 2.5 μL of blocking buffer (10 mg/mL of mouse IgG with 

5 mM azide, supplied by Sigma-Aldrich with the order of anti-Mouse-Atto647N) and 0.5 μL of 
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0.5% Phenol red (Sigma P0290) for blocking the unconjugated Anti-Mouse-IgG-Atto647N. 

Vortex thoroughly, and incubate the mixture at room temperature for 5–10 min. Mixtures without 

anti-Dld antibody were used as control. 

3. Microinjection: Anaesthetize 24–26 h post fertilization (hpf) embryos in the Danieau medium 

supplemented with 0.003% tricaine, followed by embedding in 1.2% low-melt point agarose. 

The zebrafish microinjection platform is the same as previously described (Dong et al., 2011). 

Inject 10 nL of labelled Dld antibody into the hindbrain ventricle. Release the injected embryos 

from agarose and culture them in the Danieau medium for 3–4 h. 

4. Before proceeding to fixation and immunostaining, monitor the effects of the antibody uptake 

assay under a spinning-disk confocal microscope. 

 

B. Fixation and cryosectioning of zebrafish embryos  

1. Collect embryos from the last step, wash them in PBS twice, and then transfer them to 

Eppendorf tubes with 4% paraformaldehyde (PFA) overnight at 4°C in 1× PBS buffer. 

2. Wash the fixed embryos three times with 1× PBS (5 min each time) and incubate them in 1× 

PBS buffer containing 30% sucrose overnight at 4°C.  

3. Transfer the embryos to plastic molds for preparing frozen samples with soft tips, remove the 

sucrose buffer, and add the OCT (Tissue-tek). After orienting the embryos to proper positions in 

the mold, freeze the block on dry ice. Blocks can be stored at -80°C up to several months. 

4. Cut frozen blocks into 20 μm sections on a cryostat (Leica). After placing the sections on 

Superfrost Plus slides (Fisher Scientific), these slides were dried at room temperature for 2–3 h 

and then stored at -80°C until use. 

 

C. Whole mount fluorescent immunostaining 

1. Wash the frozen cryosections in PBS-T for 5 min, then preincubate them in blocking buffer at 

4°C overnight or longer. 

2. After blocking, incubate the cryosections with primary antibodies in the blocking buffer overnight 

at 4°C. 

3. For those samples that do not continue with LR-ExM, thoroughly wash the cryosections with 

PBS-T five times × 10 min each time, and incubate with Alexa®-conjugated goat anti-rabbit 

(Alexa 568), goat anti-chicken (Alexa 488), goat anti-mouse (Alexa 488), or goat anti-guinea 

pig (Alexa 647) secondary antibodies (diluted 1:1,000) in the blocking buffer, for over 2 h at 

room temperature or overnight at 4°C. 

4. Wash the samples with PBS-T twice, and then three times with PBS (10 min each). 

5. Incubate the samples with 50% glycerol in PBS for 1 h, followed by infiltration overnight in 80% 

glycerol/PBS before imaging. 

 

D. Label Retention Expansion Microscopy (LR-ExM)  

1. For the cryosections to be used for LR-ExM, after primary antibody incubation as described 

http://www.bio-protocol.org/e4336
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above, they were incubated with trifunctional linkers [NHS-MA-Biotin conjugated anti-Chicken 

(or anti-Rabbit) IgG—for visualizing Par-3, and NHS-MA-DIG conjugated anti-Guinea Pig IgG—

for visualizing Dlic1 (200 mg/mL stock, dilute 1:100 before use)] in the blocking buffer overnight 

at 4°C in the dark.  

2. After washes in PBS (5 min each) in the dark, add 40 μL of freshly prepared gelation solution 

onto each section to cover the whole tissue sample. The gelation solution was prepared by 

deoxygenizing the gel monomer solution using a vacuum pump for over 15 min, before adding 

TEMED and APS, to enhance the effects of trifunctional linkers.  

3. Protect the sections from light, incubate in a humidity chamber, and allowe to undergo gelation 

at 37°C for 1 h.  

4. Incubate the gelated samples in the digestion buffer (see Recipes) on the slides at 37°C for 4 h 

or at room temperature overnight. At least 10-fold excess volume of digestion buffer was used 

(> 5 mL for each slide). Sufficient digestion enables sections embedded in gels to slide off the 

glass surface.  

5. Wash the gel embedded samples with excess volume of 150 mM NaCl in 6-well plates of at 

least 5 mL in each well for four times (20–30 min each time).  

6. After washing off the digestion buffer, incubate the gel samples in the post-digestion staining 

buffer (see Recipes) with 3–5 μM Alexa Fluor® 488-Streptavidin, 3–5 μM goat anti-

Digoxigenin/Digoxin Dylight® 594, anti-mouse Atto647N (1:500), and DAPI (1:1,000) in the dark 

at 4°C for 24 h.   

7. Wash the gel embedded samples four times with Milli-Q water (30 min for each wash) in the 

dark at 4°C. The samples expand to approximately four times their original size after washing 

and are then ready for imaging. 

 

E. Confocal microscopy  

Immuno-stained samples without LR-ExM were scanned using a confocal microscope (Nikon CSU-

W1 Spinning Disk/High Speed Widefield confocal microscopy, Nikon Imaging Core at UCSF) at 0.26 

μm z-step size, with a 100× Oil objective. LR-ExM samples were scanned with the same confocal 

microscope at 0.26 μm z-step size, with a 60× water immersion (WI) objective.  

 

Data analysis 

 

The colocalization of cytosolic Par-3 with Dlic1 and Dld endosomes in mitotic RGP was described in 

our recent publication (Zhao et al., 2021). We chose the central plane area between the nuclei of two 

nascent daughter cells as the Region of Interest (ROI) for colocalization analyses of Par-3, Dlic1, and 

Dld endosomes in the acquired images. 

 

A. The acquired images of immuno-stained RGP cells in the zebrafish embryonic forebrain were 

segmented, and maximum intensity projections of ten consecutive z-planes covering the central 

http://www.bio-protocol.org/e4336
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cytoplasmic area of the cells were generated (0.26 μm z-step interval, the Max Z plane covered 

2.6 μm thickness).  

1. For the images of immuno-stained samples, the region of 60 × 100 pixels (1 pixel = 0.065 μm) 

between two nuclei of dividing RGP daughter cells was cropped and saved for colocalization 

analysis in FIJI (Fiji Is Just ImageJ) (Figure 1A). 

2. For the images of LR-ExM processed samples, the area of 120 × 200 pixel (1 pixel = 0.11 μm) 

in the central cytoplasmic area between the nuclei was selected for JACoP colocalization 

analyses. 

 

B. JACoP (Just Another Co-localization Plugin) was intalled into FIJI, if it was not in the list of Plugins. 

We then split the channel of the cropped images and chose those three channels for colocalization 

analyses to display on the desktop (Figure 1B).  

JACoP can be found and downloaded from https://imagej.nih.gov/ij/plugins/track/jacop2.html  

 

C. Running JACoP in FIJI for colocalization analysis 

1. Open a cropped out image from step A. 

2. If they are merged, split the channels in a compositive tiff file (Figure 1B). 

a. Image>Color>Split Channels 

3. Open JACoP 

a. Plugins>JACoP (Figure 1C). 

b. Click it to open a new window of JACoP plugin under FIJI (Figure 2). 

 

 

Figure 1. Preparation of segmented RGP images for colocalization analyses. A. The 

central cytoplasmic area between the dividing cell nuclei was cropped and saved (the white 

rectangle in the image is 60 × 100 pixel. The size was shown by the red line highlighting w and 

h in FIJI). B. The image was split into three single channel images. C. Locating and choosing 

JACoP in the “Plugins” of FIJI. 

 

http://www.bio-protocol.org/e4336
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Figure 2. The interface for choosing channels, M1 & M2 coefficients, threshold, and 

Costes’ automatic threshold. The two images in C1 and C2 illustrate the effect after setting 

the thresholds. 

 

4. At the top of the window, select and compare the images of two different channels (C1 & C2) 

already opened by FIJI under “Image A” and “Image B” (left panel in Figure 2).  

5. Then select the M1 & M2 coefficients (Manders’ coefficients) analysis to perform in the window 

of “Just Another Colocalisation Plugin” (left panel in Figure 2).  

6. Check the tabs in Red for required settings before applying the analysis. To choose the correct 

functions in JACoP for analyses, please refer to the introduction of the plugin (Cordelieres and 

Bolte, 2008). In our study, we are only interested in Manders’ coefficients. CCF (cross-

correlation coefficient) is not used for our study and would not be discussed here. 

a. Threshold (at the bottom of left panel in Figure 2) 

i. This is the threshold set for independent experiment. To remove potential background 

noise, the threshold of each channel was set in JACoP using a blank area on the image 

(i.e., without tissue samples) as a negative control. 

ii. You can determine the numbers consistently using the Image>Adjust>Threshold and 

use a predetermined automatic threshold, according to the masking area shown in each 

channel (right panel of Figure 2). 

iii. Costes’ automatic threshold was normally applied for each measurement, which is an 

algorithm to identify and remove noise using scatter plotting of randomized images 

generated from the image under analysis (Costes et al., 2004). It would generate 

another pair of automatically quantified M1 & M2 coefficients.  

iv. For negative control images, the M1 & M2 coefficients would be “0” using both 

thresholds. 

b. Micro. 

http://www.bio-protocol.org/e4336
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i. This is the information about your microscope (Figure 3A). 

ii. If you are using the image acquired from the Bio-imaging software (an OME.TIF or 

a .nd2, etc.), that information should be automatically associated with your image (xy 

calib nm, 65; z calib nm, 260, for the 100× objective). 

iii. Enter in Wavelength excitation information. 

c. Costes’ rand° 

i. The minimum “xy block size” can be set at 2. “z block size” was always set at 1, as we 

analyzed the Max-Z projection of image stacks (Figure 3B). 

ii. You can estimate this, for example: 

1). All the pictures collected from the confocal microscope have the same size of 2048 

× 2048 pixel, and the pixel size of the image is approximately 65 nm.  

2). Typically, the size of endosomes is larger than 200 nm. 

3). To cover the distance of 200 nm, we need at least 2 pixels from both channels. 

4). When using images from LR-ExM samples, the minimum “xy block size” was 

usually set to 4. Because the sample was expanded for about 4 times, the minimum 

size of endosomes in the sample was enlarged to be over 800 nm. As we used a 

60× WI objective for scanning LR-ExM samples, this increased the pixel size of the 

image to be about 110 nm. Therefore, to cover a distance of 800 nm, we need at 

least 4 pixels from both channels. 

d. Obj. is the tab for checking parameter settings. No change should be required. 

7. After going through each step, click “Analyze” at the bottom (Figure 3). The results are 

generated in a new window.  

 

Figure 3. Demonstration of JACoP interface when choosing different tabs. A. Micro. 

displays the information of microscopy. B. Costes’ rand° displays the selection of xy block size 

for analysis. 

 

http://www.bio-protocol.org/e4336
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D. To compare all three channels, the above steps should be repeated in pairs of two channels. All the 

results from the same sample are saved together in one txt. file. To achieve enough repeats for 

statistical analyses, the above steps were repeated for each image from all cells.  

 

E. The statistics of Par-3, Dlic1, and Dld endosomes colocalization in each group of samples were 

assessed by Prism 9. For the images from the same experiment, M1 & M2 coefficients of Costes’ 

automatic threshold were also been used for comparison. For all images from independent 

experiments, we only used M1 & M2 coefficients of predetermined thresholds for comparison.  

 

F. The colocalization relationship of those three proteins has been more clearly demonstrated by LR-

ExM samples. As shown in Figure 4, the size of RGPs that have undergone LR-ExM is almost four 

times larger than normal immunostained RGPs shown in Figure 1. The colocalization analyses 

showed that similar colocalization coeffiecients for the three proteins have been found from both 

sets of data (Zhao et al., 2021).  

 

 

Figure 4. Preparation of segmented images of LR-ExM for colocalization analyses. A. The 

central cytoplasmic area between the dividing cell nuclei was cropped and saved (the white 

rectangle in the image is 150 × 250 pixel. The size was shown by w and h in FIJI. This picture 

is modified from (Zhao et al., 2021), some rights reserved; exclusive licensee AAAS. Distributed 

under a CC BY-NC 4.0 License (http://creativecommons.org/licenses/by-nc/4.0/). B. The image 

of the white rectangle area in A was split into three single channel images without showing DAPI. 

The size of the segmented area has been shown on the top of each frame. 

 

Notes  

 

1. The gelation buffer for LR-ExM should only be prepared freshly to achieve stable effects. 

2. All the secondary antibodies conjugated with fluorophores were centrifuged and aliquoted (20 

μL per tube) into light shielded Eppendorf tubes, and stored in a -80°C freezer. 

3. Trifunction linkers for LR-ExM can only be stored at 4°C and shielded from light. 

http://www.bio-protocol.org/e4336
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Recipes 

 

1. 30× Danieau’s embryo medium 

1740 mM NaCl, 21 mM KCl, 12 mM MgSO4·7H2O, 18 mM Ca(NO3)2, 150 mM HEPES buffer 

2. Blocking buffer for immunostaining 

0.1% Tween 20, 0.25% Triton X-100 with 1% dimethyl sulfoxide (DMSO) and 5% normal goat 

serum in 1× PBS, pH 7.4. 

3. Washing buffer 

1× PBS with 0.05% Tween 20 

4. Post-digestion staining buffer 

10 mM HEPES, 150 mM NaCl in MilliQ water, pH 7.5 

5. Monomer solution:  

Sodium acrylate 0.86 g/mL, Acrylamide 0.25 g/mL, N,N′-Methylenebis-acrylamide 0.015 g/mL, 

Sodium chloride 1.17 g/mL in PBS (1×). 

 

LR-ExM gelation buffer and digestion buffer are prepared by following the instruction in the original 

publication (Shi et al., 2021):  

6. Gelation buffer 

190 μL of Monomer solution with 5 μL of 8% TEMED and 5 μL 8% APS. 

7. Digestion buffer 

8 units/mL of Proteinase K in 50 mM Tris pH 8.0, 1 mM EDTA, 1 M NaCl, 0.5% of Triton X-100 
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